Chapter 385

Mixed Models Tests for Two Proportions in a 2-Level Hierarchical Design (Level-1 Randomization)

Introduction

This procedure calculates power and sample size for a two-level hierarchical mixed-effects logistic regression in which clusters (groups, classes, hospitals, etc.) of subjects are measured one time (cross-sectional) on a binary variable. The goal of the study is to compare the two group proportions.

In this design, the subjects are the level one units, and the clusters are the level two units. Each subject in a particular cluster (level two unit) is randomized individually to one of two possible interventions. Note that a companion procedure power analyzes the other case in which the randomization occurs for the level two units (the clusters).

Technical Details

Our formulation comes from Ahn, Heo, and Zhang (2015), chapter 5, section 5.7.2, pages 179-181. The hierarchical mixed-effects logistic regression model that is adopted is

\[
\log \left( \frac{p_{ij}}{1 - p_{ij}} \right) = \beta_0 + \delta X_{ij} + u_i
\]

where

- \( Y_{ij} \) is the binary response of the \( j \)th subject in the \( i \)th cluster.
- \( p_{ij} \) is \( E(Y_{ij}|X_{ij}) \). Assume \([p_{ij}|(X_{ij} = 0)] = p_2 \) and \([p_{ij}|(X_{ij} = 1)] = p_1 \)
- \( \beta_0 \) is the fixed intercept.
- \( \delta \) is the treatment effect of interest.
$X_{ij}$ is an indicator variable that is set to 1 if subject $j$ in cluster $i$ receives intervention 1 and 0 otherwise.

$u_i$ is a random effect (subject-specific intercept) term for the $i$th cluster that is distributed as $N(0, \sigma_u^2)$.

$\sigma_u^2$ is variance of the level two (cluster) random effects.

$\rho$ is the intraclass correlation (ICC), where $\rho = \text{Corr}(Y_{ij}, Y_{ij'}) = (\sigma_u^2 / (\sigma_u^2 + \pi^2 / 3))$.

The test of significance of the $\delta$ coefficient in the logistic regression analysis is the test statistic of interest.

The power can be calculated using

$$Power = \Phi \left( \frac{|p_1 - p_2|\sqrt{KM_2/[1 - \rho]} - \Phi(1 - \alpha/2)\sqrt{(1 + \frac{1}{\lambda})\bar{p}(1 - \bar{p})}}{\sqrt{p_2(1 - p_2) + p_1(1 - p_1)/\lambda}} \right)$$

where

- $K$ is the number of clusters in the study.
- $M1$ is the average number of subjects per cluster in group 1.
- $M2$ is the average number of subjects per cluster in group 2.
- $\lambda$ is $M_1/M_2$.
- $\bar{p}$ is $\left(\frac{p_1 + \lambda p_2}{1 + \lambda}\right)$.

This power function is used in a binary search algorithm to determine $p_1, K_1$, or $M$.

### Procedure Options

This section describes the options that are specific to this procedure. These are located on the Design tab. For more information about the options of other tabs, go to the Procedure Window chapter.

### Design Tab

The Design tab contains most of the parameters and options that you will be concerned with.

#### Solve For

This option specifies the parameter to be solved for from the other parameters. The parameters that may be selected are Effect Size, Power, K, or M1.

Under most situations, you will select either Power to calculate power or K to calculate the number of clusters. Occasionally, you may want to fix the number of clusters and find the necessary cluster size.

Note that the value selected here always appears as the vertical axis on the charts.

The program is set up to calculate power directly. To find appropriate values of the other parameters, a binary search is made using an iterative procedure until an appropriate value is found. This search considers integer values of $M1$ only.
Power and Alpha

Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis, and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null hypothesis is not rejected.

Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now, 0.90 (Beta = 0.10) is also commonly used.

A single value may be entered or a range of values such as 0.8 to 0.95 by 0.05 may be entered.

If your only interest is in determining the appropriate sample size for a confidence interval, set power to 0.5.

Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true null hypothesis is rejected.

Values must be between zero and one. Usually, the value of 0.05 is used for alpha and this has become a standard. This means that about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents the risk of a type-I error you are willing to take in your experimental situation.

You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

Sample Size – Number of Clusters and Subjects – Number of Clusters

K (Number of Clusters)
This is the number of clusters (classes, hospitals, practices, etc.) in the study. Subjects in each of these clusters are randomly assigned to one of the two interventions (group 1 or 2). The study sample size is equal to the number of clusters times the number of subjects per cluster.

Range
This value must be a positive integer.

List
You can enter a list of values such as "10 20 30". A separate analysis will be run for each element in the list.

Sample Size – Number of Clusters and Subjects – Number of Subjects Per Cluster

M1 (Group 1 Subjects Per Cluster)
This is the average number of items (subjects) per cluster receiving intervention (treatment) 1 and thus assigned to group 1. PASS arbitrarily calls group 1 the Treatment Group.

Range
This value must be a positive number that is at least 1.

It can be a decimal (fractional) number such as ’2.7’. The resulting values of N1 and N2 will be rounded to integers.

List
You can use a list of values such as "10 15 20". A separate analysis will be run for each element in the list.
M2 (Group 2 Subjects Per Cluster)
This is the average number of items (subjects) per cluster receiving intervention (treatment) 2 and thus assigned to group 2. PASS arbitrarily calls group 2 the Control Group. The sample size for this group is equal to the number of clusters times the number of group 2 subjects per cluster.

Range
This value must be a positive number that results in a group sample size that is at least 1. It can be a decimal (fractional) number such as ‘2.7’.

Using 'M1'
If you simply want to use a multiple of \( M1 \), the value for group 1, you would enter the multiple followed by "\( M1 \)" , with no blanks. If you want to use \( M1 \) directly, you do not have to enter the leading "1". For example, all of the following are valid entries:
\[ M1 \ 2M1 \ 1.5M1 \ 0.5M1 \ 10 \ 15. \]

List
You can use a list of values such as "10 20 30" or "M1 2M1 3M1".

Effect Size
P1 Input Type
Indicate what type of values to enter to specify the effect size: P1 - P2. Regardless of the entry type chosen, the test statistics used in the power and sample size calculations are the same. The value of P1 is calculated from the value entered. This option is simply given for convenience in specifying the effect size.

The choices are

- **Proportions**
  Enter P1 (Group 1 Proportion|H1) and P2 (Group 2 Proportion).

- **Differences**
  Enter D1 (Difference|H1 = P1-P2) and P2 (Group 2 Proportion).

- **Ratios**
  Enter R1 (Ratio|H1 = P1/P2) and P2 (Group 2 Proportion).

- **Odds Ratios**
  Enter OR1 (Odds Ratio|H1 = Odds1/Odds2) and P2 (Group 2 Proportion).

P1 (Group 1 Proportion |H1)
Enter a value for the proportion in group 1 (the experimental or treatment group) under the alternative hypothesis, H1. The power calculations assume that this is the actual value of the proportion.

You can enter a single value such as 0.1 or a series of values such as 0.1 0.2 0.3 or 0.1 to 0.9 by 0.1.

Note that values must be between zero and one and cannot be equal to P2.
D1 (Difference|H1 = P1 – P2)
This option specifies the difference between the two proportions under the alternative hypothesis, H1. This difference is used with P2 to calculate the value of P1 using the formula: P1 = Diff + P2.

The power calculations assume that P1 is the actual value of the proportion in group 1 (experimental or treatment group).

You can enter a single value such as 0.05 or a series of values such as 0.03 0.05 0.10 or 0.01 to 0.05 by 0.01.
Differences must be between -1 and 1. They cannot take on the values -1, 0, or 1.

R1 (Ratio|H1 = P1/P2)
This option specifies the ratio between the two proportions P1 and P2. This ratio is used with P2 to calculate the value of P1 using the formula: P1 = (Ratio) x (P2).

The power calculations assume that P1 is the actual value of the proportion in group 1 (experimental or treatment group).

You can enter a single value such as 0.5 or a series of values such as 0.5 0.6 0.7 0.8 or 1.25 to 2.0 by 0.25.
Ratios must be greater than zero. They cannot take on the value of one.

OR1 (Ratio|H1 = Odds1/Odds2)
This option specifies the odds ratio of P1 and P2, where Odds1 is the odds in group 1 under the alternative hypothesis. This ratio is used with P2 to calculate the value of P1 using the formula: P1 = (OR1)(P2) / (1 - P2 + (OR1)(P2)). The power calculations assume that P1 is the actual value of the proportion in group 1 (experimental or treatment group).

You may enter a range of values such as 0.5 0.6 0.7 0.8 or 1.25 to 2.0 by 0.25. Ratios must be greater than zero. They cannot take on the value of one.

P2 (Group 2 Proportion)
Enter a value for the proportion in group 2 (the control, baseline, standard, or reference group).
Values must be between 0 and 1.

You can enter a single value such as 0.1 or a series of values such as 0.1 0.2 0.3 or 0.1 to 0.5 by 0.1.

Effect Size – Intracluster Correlation
p (Intracluster Correlation, ICC)
This is the value of the intracluster (or intraclass) correlation coefficient. It may be interpreted as the correlation between any two observations in the same cluster. It may also be thought of as the proportion of the variation in response that can be accounted for by the between-cluster variation.

Possible values are from 0 to just below 1. Typical values are between 0.0001 and 0.05.
You may enter a single value or a list of values.
Example 1 – Calculating Power

Suppose that a two-level hierarchical design is planned in which there will be only one measurement per subject and treatments will be applied to subjects (level-one units). The analysis will be a mixed-effect logistic regression. The following parameter settings are to be used for the power analysis: $P1 = 0.6; P2 = 0.5; \rho = 0.05; M1= 15 \text{ or } 25; M2 = M1; \alpha = 0.05; \text{ and } K = 10, 20, 30, 40$.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Mixed Models Tests for Two Proportions in a 2-Level Hierarchical Design (Level-1 Randomization) procedure window. You may then make the appropriate entries as listed below, or open Example 1 by going to the File menu and choosing Open Example Template.

Option

<table>
<thead>
<tr>
<th>Design Tab</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Solve For</td>
<td>Power</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>K (Number of Clusters)</td>
<td>10 20 30 40</td>
</tr>
<tr>
<td>M1 (Group 1 Subjects Per Cluster)</td>
<td>15 25</td>
</tr>
<tr>
<td>M2 (Group 2 Subjects Per Cluster)</td>
<td>M1</td>
</tr>
<tr>
<td>P1 Input Type</td>
<td>Proportions</td>
</tr>
<tr>
<td>P1 (Group 1 Proportion</td>
<td>H1)</td>
</tr>
<tr>
<td>P2 (Group 2 Proportion)</td>
<td>0.5</td>
</tr>
<tr>
<td>$\rho$ (Intracluster Correlation, ICC)</td>
<td>0.05</td>
</tr>
</tbody>
</table>

Annotated Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th>Power</th>
<th>Total Subjects</th>
<th>Clusters</th>
<th>Group 1 Subjects Per Clus</th>
<th>Group 2 Subjects Per Clus</th>
<th>Group 1 Prop</th>
<th>Group 2 Prop</th>
<th>Prop Diff</th>
<th>Odds Ratio</th>
<th>ICC</th>
<th>Alpha</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.4306</td>
<td>300</td>
<td>10</td>
<td>15</td>
<td>15</td>
<td>0.6000</td>
<td>0.6000</td>
<td>0.1000</td>
<td>1.500</td>
<td>0.0500</td>
<td>0.050</td>
</tr>
<tr>
<td>0.6359</td>
<td>500</td>
<td>10</td>
<td>25</td>
<td>25</td>
<td>0.6000</td>
<td>0.6000</td>
<td>0.1000</td>
<td>1.500</td>
<td>0.0500</td>
<td>0.050</td>
</tr>
<tr>
<td>0.7152</td>
<td>600</td>
<td>20</td>
<td>15</td>
<td>15</td>
<td>0.6000</td>
<td>0.6000</td>
<td>0.1000</td>
<td>1.500</td>
<td>0.0500</td>
<td>0.050</td>
</tr>
<tr>
<td>0.9045</td>
<td>1000</td>
<td>20</td>
<td>25</td>
<td>25</td>
<td>0.6000</td>
<td>0.6000</td>
<td>0.1000</td>
<td>1.500</td>
<td>0.0500</td>
<td>0.050</td>
</tr>
<tr>
<td>0.8727</td>
<td>900</td>
<td>30</td>
<td>15</td>
<td>15</td>
<td>0.6000</td>
<td>0.6000</td>
<td>0.1000</td>
<td>1.500</td>
<td>0.0500</td>
<td>0.050</td>
</tr>
<tr>
<td>0.9795</td>
<td>1500</td>
<td>30</td>
<td>25</td>
<td>25</td>
<td>0.6000</td>
<td>0.6000</td>
<td>0.1000</td>
<td>1.500</td>
<td>0.0500</td>
<td>0.050</td>
</tr>
<tr>
<td>0.9474</td>
<td>1200</td>
<td>40</td>
<td>15</td>
<td>15</td>
<td>0.6000</td>
<td>0.6000</td>
<td>0.1000</td>
<td>1.500</td>
<td>0.0500</td>
<td>0.050</td>
</tr>
<tr>
<td>0.9962</td>
<td>2000</td>
<td>40</td>
<td>25</td>
<td>25</td>
<td>0.6000</td>
<td>0.6000</td>
<td>0.1000</td>
<td>1.500</td>
<td>0.0500</td>
<td>0.050</td>
</tr>
</tbody>
</table>

References

Report Definitions
Power is the probability of rejecting a false null hypothesis.
N is the total number of subjects in the study.
K is the number of clusters.
M1 is the average number of items (subjects) per cluster in group one, which is designated as the treatment group.
M2 is the average number of items (subjects) per cluster in group two, which is designated as the control group.
P1 is the proportion for group 1 (treatment) assumed by the alternative hypothesis.
P2 is the proportion for group 2 (control, standard, reference, baseline).
Prop Diff = P1 - P2 is the difference in the group proportions assumed by the alternative hypothesis.
Odds Ratio = Odds1/Odds2 is the odds ratio assuming the alternative hypothesis.
ICC is the intracluster correlation.
Alpha is the probability of rejecting a true null hypothesis.

Summary Statements
A total sample size of 300 subject, which were obtained by sampling 10 clusters with an average of 15 subjects per cluster in group one and 15 subjects per cluster in group two, achieve 43.06% power to detect a difference between the group proportions of 0.1000. The proportion in group 1 is assumed to be 0.6000 under the alternative hypothesis. The proportion in group 2 is 0.5000. The test statistic used is the effect regression coefficient from a mixed-effects logistic regression model. The intracluster correlation is 0.0500, and the significance level of the test is 0.050. Each subject was individually randomized to one of the two groups.

This report shows the power for each of the scenarios.

Plots Section

These plots show the power versus the cluster count for the two cluster size values.
Example 2 – Calculating Sample Size (Number of Clusters)

Continuing with the last example, suppose the researchers want to determine the number of clusters needed to achieve 90% power for both values of M1 and M2.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Mixed Models Tests for Two Proportions in a 2-Level Hierarchical Design (Level-1 Randomization) procedure window. You may then make the appropriate entries as listed below, or open Example 2 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Design Tab</strong></td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>K (Number of Clusters)</td>
</tr>
<tr>
<td>Power</td>
<td>0.90</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>M1 (Group 1 Subjects Per Cluster)</td>
<td>15 25</td>
</tr>
<tr>
<td>M2 (Group 2 Subjects Per Cluster)</td>
<td>M1</td>
</tr>
<tr>
<td>P1 Input Type</td>
<td>Proportions</td>
</tr>
<tr>
<td>P1 (Group 1 Proportion</td>
<td>H1)</td>
</tr>
<tr>
<td>P2 (Group 2 Proportion)</td>
<td>0.5</td>
</tr>
<tr>
<td>$\rho$ (Intracluster Correlation, ICC)</td>
<td>0.05</td>
</tr>
</tbody>
</table>

Output

Click the Calculate button to perform the calculations and generate the following output.

**Numeric Results**

<table>
<thead>
<tr>
<th>Power</th>
<th>Total Subjects</th>
<th>Clusters</th>
<th>Group 1 Subjects Per Clus</th>
<th>Group 2 Subjects Per Clus</th>
<th>Group 1 Prop</th>
<th>Group 2 Prop</th>
<th>Prop Diff</th>
<th>Odds Ratio</th>
<th>ICC</th>
<th>Alpha</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.9016</td>
<td>990</td>
<td>33</td>
<td>15</td>
<td>15</td>
<td>0.6000</td>
<td>0.5000</td>
<td>0.1000</td>
<td>1.500</td>
<td>0.05</td>
<td>0.050</td>
</tr>
<tr>
<td>0.9045</td>
<td>1000</td>
<td>20</td>
<td>25</td>
<td>25</td>
<td>0.6000</td>
<td>0.5000</td>
<td>0.1000</td>
<td>1.500</td>
<td>0.05</td>
<td>0.050</td>
</tr>
</tbody>
</table>

This report shows the necessary value of K for each scenario.
Example 3 – Calculating Sample Size (Number of Subjects)

Continuing with the last example, suppose the researchers want to determine the number of subjects per cluster needed to achieve 90% power for all values of K. They want to consider what will happen if the M2 is twice as large as M1.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Mixed Models Tests for Two Proportions in a 2-Level Hierarchical Design (Level-1 Randomization) procedure window. You may then make the appropriate entries as listed below, or open Example 3 by going to the File menu and choosing Open Example Template.

**Option** | **Value**
--- | ---
**Design Tab** |  
Solve For | M1 (Group 1 Subjects Per Cluster)  
Power | 0.90  
Alpha | 0.05  
K (Number of Clusters) | 10 20 30 40  
M2 (Group 2 Subjects Per Cluster) | 2M1  
P1 Input Type | Proportions  
P1 (Group 1 Proportion|H1) | 0.6  
P2 (Group 2 Proportion) | 0.5  
ρ (Intracluster Correlation, ICC) | 0.05

Output

Click the Calculate button to perform the calculations and generate the following output.

**Numeric Results**

<table>
<thead>
<tr>
<th>Power</th>
<th>Total Subjects</th>
<th>Clusters</th>
<th>Group 1 Subjects Per Clus</th>
<th>Group 2 Subjects Per Clus</th>
<th>Group 1 Prop</th>
<th>Group 2 Prop</th>
<th>Prop Diff</th>
<th>Odds Ratio</th>
<th>ICC</th>
<th>Alpha</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.9013</td>
<td>1110</td>
<td>10</td>
<td>37</td>
<td>74</td>
<td>0.6000</td>
<td>0.5000</td>
<td>0.1000</td>
<td>1.500</td>
<td>0.0500</td>
<td>0.050</td>
</tr>
<tr>
<td>0.9086</td>
<td>1140</td>
<td>20</td>
<td>19</td>
<td>38</td>
<td>0.6000</td>
<td>0.5000</td>
<td>0.1000</td>
<td>1.500</td>
<td>0.0500</td>
<td>0.050</td>
</tr>
<tr>
<td>0.9155</td>
<td>1170</td>
<td>30</td>
<td>13</td>
<td>26</td>
<td>0.6000</td>
<td>0.5000</td>
<td>0.1000</td>
<td>1.500</td>
<td>0.0500</td>
<td>0.050</td>
</tr>
<tr>
<td>0.9219</td>
<td>1200</td>
<td>40</td>
<td>10</td>
<td>20</td>
<td>0.6000</td>
<td>0.5000</td>
<td>0.1000</td>
<td>1.500</td>
<td>0.0500</td>
<td>0.050</td>
</tr>
</tbody>
</table>

This report shows the necessary values of M1 and M2 for each scenario.
Example 4 – Validation using Ahn, Heo, and Zhang (2015)

Ahn, Heo, and Zhang (2015) page 181 provide a table in which several scenarios are reported. We will validate this procedure by duplicating the first row.

The following parameter settings were used: Power = 0.80; \( P_1 = 0.6; \ P_2 = 0.4; \ \rho = 0.1; \ M_1 = M_2 = 10; \ ICC = 0.1; \) and \( \alpha = 0.05. \) The value of \( K \) is 10. The realized power value is 0.851.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Mixed Models Tests for Two Proportions in a 2-Level Hierarchical Design (Level-1 Randomization) procedure window. You may then make the appropriate entries as listed below, or open Example 4 by going to the File menu and choosing Open Example Template.

Design Tab

Solve For ………………………………………… Power
Alpha……………………………………………. 0.05
K (Number of Clusters)…………………... 10
M1 (Group 1 Subjects Per Cluster) ……… 10
M2 (Group 2 Subjects Per Cluster) ……… M1
P1 Input Type ………………………………… Proportions
P1 (Group 1 Proportion|H1)………………… 0.6
P2 (Group 2 Proportion) ……………………. 0.4
\( \rho \) (Intracluster Correlation, ICC)……….. 0.1

Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th>Group 1 Subjects Per Clus</th>
<th>Group 2 Subjects Per Clus</th>
<th>Group 1 Prop P1</th>
<th>Group 2 Prop P2</th>
<th>Prop Diff P1-P2</th>
<th>Odds Ratio OR</th>
<th>ICC ( \rho )</th>
<th>Alpha</th>
</tr>
</thead>
<tbody>
<tr>
<td>M1</td>
<td>M2</td>
<td>P1</td>
<td>P2</td>
<td>0.6000</td>
<td>0.4000</td>
<td>0.2000</td>
<td>2.250</td>
</tr>
<tr>
<td>10</td>
<td>10</td>
<td>0.6000</td>
<td>0.4000</td>
<td>0.2000</td>
<td>2.250</td>
<td>0.1000</td>
<td>0.050</td>
</tr>
</tbody>
</table>

PASS calculates the same of power: 0.8514.

(We noticed that if you search for the smallest value of \( K \), the power condition is met with \( K = 9. \) )